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Notes

Disclaimer We take great pride in the accuracy of information given in this

manual, but due to nature of software developments, be aware that

software specifications and features of this product can change

without notice.  No liability can be accepted by Denford Limited for

loss, damage or injury caused by any errors in, or omissions from,

the information supplied in this manual.

Screenshots Please note that any screenshots are used for explanation

purposes only.

Language This manual is written using European English.

Contact Any comments regarding this manual should be referred to the

following e-mail address:  customer_services@denford.co.uk

Updates Any updates to this manual will be posted in the "Downloads"

section of the Denford website:  http://www.denford.co.uk

About this Manual
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Conventions used in this Manual
Mouse Usage When asked to left click on a menu tile or object, click the LEFT

mouse button ONCE.  When asked to right click on a menu tile or

object, click the RIGHT mouse button ONCE.  When asked to

double click on an object, click the LEFT mouse button TWICE.

When reference to either a left mouse button or right mouse button

click command is omitted, always perform one click with the left

mouse button.

Underlined text This is used to show key words. The full definition of any terms are

given in the Jargon Buster helpboxes.  Similar helpboxes are also

used to display any Important Notes or Tips to help you use the

program.

"Quotation Marks" Quotation marks are used to specify any software menu, title and

window selections, e.g. click the "File" menu would mean click the

left mouse button once, when the cursor is positioned over the File

menu label.   When a sequence of menu commands are requested,

the menu and option names are separated by a vertical line, for

example - Click "File | Open" would mean open the File menu, then

click on the Open option.

Bold Text Bold Text is used to show any characters, or text, that must be

entered, e.g. type file1 would mean type the word file1 into the

appropriate text entry box.

[Square Brackets] Square brackets are used to show any on-screen software button

selections, e.g. Click the [OK] button would mean click the left

button of the mouse once, when the cursor is directly pointing over

the button labeled OK.

[Bold Square Brackets] Bold square brackets containing text show individual keys to press

on your qwerty keyboard, e.g. press [Enter] would mean press the

Enter key.  If a number of  keys must be pressed in sequence they

are shown with plus signs outside any square brackets, e.g. press

[Alt] + [Enter] would mean press the Alt key first followed by the

Enter key second.  If a number of keys must be pressed

simultaneously they are shown with plus signs inside any square

brackets, e.g. press [Alt + Enter] would mean press both the Alt

key and Enter key together, at the same time.
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Introduction
Congratulations on your purchase of MillCAM Designer 2 software.

MillCAM Designer has been specially written to lead you through

your first experiences of CAD/CAM, into the exciting stages of CNC

manufacture!

MillCAM Designer 2 is a CNC design system which allows the user

to draw in a graphical environment.  The design is then converted

into a G-Code file, which is produced automatically.

The work area is specified at the start of the program.  This

represents the billet size available in the CNC machine being used.

Designs are created by combining elements, which can be added or

removed at any time.  The coloured toolpath follows the order of

element placement in the work area.  Different line thicknesses show

different tool diameters and different colours represent different

depths of cut.  By using co-ordinates Mill CAM Designer 2  allows

the size and position of elements to be edited with great accuracy.

Designs can be saved and loaded at any time,  so unfinished

drawings can be completed later, changes can be made and a

library of commonly used parts can be compiled.

MillCAM designer has been developed to be as simple to use as

possible.  It will allow your CNC machine to be used as a "everyday

tool" rather  than one reserved for special occasions.

CAD/CAM refers to Computer Aided Design and Manufacture, using a computer to

help you plan your design from drawing into production.

CNC refers to Computer Numerical Control, the automatic system used to control a

machine tool.

A G-Code  is a series of letters and numbers that make up the language used by

CNC machinery.

The work area represents the surface available for machining.

A billet is the piece of material you place in the milling machine.

Elements are the different shapes that are put together to make a design in

MillCAM.

The tool path shows the route followed by the CNC machine, when cutting the

design. The order in which elements are cut follows the order in which they are

placed in the work area.

  Jargon Buster - x
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New Features in MillCAM Designer 2
At Denford Limited we constantly try to make our  machines and

software easier to use.  As a result of this many new features have

been added to Mill Cam Designer 2, which include:

• Preset student projects.

• Additional cutting depths.

• Machine time calculated when G-codes are produced.

• Three Dimensional gradient represented by colour shade.

• Ability to import Data Exchange Files (DXF) from popular CAD

programs e.g. AutoCAD, Corel, Autosketch.

• Co-ordinate positioning of elements.

• Advanced menu featuring element grouping, snap to elements

and locking axes.

• Free project and program support materials available, via the

Denford website (http://www.denford.com).
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Minimum System Requirements
The following hardware is required to run MillCAM Designer 2.

System Requirements:

• IBM and 100% compatibles.

• Minimum processor: 486 DX2/66.

Recommended processor: Pentium.

• 8MB RAM with Win 3.xx.

16MB RAM with Windows 95/98/NT.

• Microsoft 100% compatible mouse.

• A VGA graphics card is required.

• Keyed versions of MillCAM Designer require a parallel port for the

security key (dongle).
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Security Devices
Your MillCAM Designer installation program will be preformatted,

ready for use with one of the following security devices:

1) Flash Software
This version does not require a security key.  When first starting

MillCAM Designer, a screen will appear displaying your user

information and licence details.

A single seat licence can be installed to only one computer

station at the registered establishment.

A multiple seat licence can be installed to the specified number

of computer stations at the registered establishment.

2) Keyed Software
This version uses a security key, called a dongle.

When using the Keyed version of the software, MillCAM
Designer will not run without the Denford Security Dongle.

Fit the dongle onto the parallel port of your computer.

The parallel port is usually positioned on the back panel of your
computer - a long, thin 25 pin male connector plug.  Note that
your parallel port may be labelled as the printer port.

The dongle has a pass-through feature, allowing data to be sent
to other external devices, such as printers, scanners or zip
drives, when the MillCAM software is not being used.  Simply
plug the parallel port cable, supplied with your external device,
directly into the back of the dongle.
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Installation Procedure - Windows 3.xx

The MillCAM Designer 2

icon looks like this.

Follow these instructions to install the Denford MillCAM Designer 2
software onto a computer running Windows 3.xx.  Whilst running
Windows on your computer:

1) Insert the MillCAM Designer 2 floppy disk into your floppy disk
drive, usually labelled drive "a:".

2) From "program manager" select "run" from the "file" menu.

3) A dialogue box will appear.  Type in the command line box
a:install and press [Enter].

4) This will run the Denford install program.  Pressing [Enter] will
install MillCAM Designer 2 onto your hard disk.  It will also create
a group window  and place the "MillCAM Designer 2" icon in this
group window.

5) Before using MillCAM Designer 2 for the first time, ensure that
keyed versions of the software have the dongle fitted to the
parallel port of your computer (see page 8).  If you did not receive
a dongle, you will be using a flash version of the software (see
page 8).

It is recommended that

you allow the Denford

installation program to

create its own

directories and set up its

default values.  If you

find these inconvenient,

then feel free to alter

them.

  Note - x

A dialogue box is a window that opens to let you enter text into a program.

The command line is where any text entries are entered in a dialogue box.

An icon  is a small picture, displayed in Windows.  When you double click the icon,

the program associated with that icon will run.

A program group, or group window is where a selection of icons can be stored

together in the Windows environment.

  Jargon Buster - x

The MillCAM Designer Projects

icon looks like this.

MillCAM Designer 2

software ships in two

different formats: Win

3.xx on floppy disks and

Win 95/98/NT on CD-

ROM.

Do not attempt to install

the Win 95/98/NT

version of MillCAM

Designer 2 onto a  Win

3.xx computer!

  Note - x
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Installation Procedure - Windows 95/98/NT

MillCAM Designer 2

software ships in two

different formats: Win

3.xx on floppy disks and

Win 95/98/NT on CD-

ROM.

Do not attempt to install

the Win 3.xx version of

MillCAM Designer 2

onto a Win 95/98/NT

computer!

  Note - x Follow these instructions to install the Denford MillCAM Designer

software onto a computer running Windows 95/98/NT.  Whilst

running Windows on your computer:

1) Insert the MillCAM Designer CD-ROM into your CD-ROM drive.  If

the autorun feature is enabled on your computer, the "MillCAM

Designer Installation" start-up window will automatically appear -

move to section 4).  Otherwise continue as outlined below.

2) Double-click the left mouse button on the "My Computer" icon. In

the "My Computer" window find your floppy disk drive icon (usually

labelled "d:" or "e:" and double-click the left mouse button on this

icon.

3) The contents of the CD-ROM will be displayed in a new window.

Double-click the left mouse button on the file named "Start.exe" to

display the "MillCAM Designer Installation" start-up window.

4) If you have been supplied with a flash screen version of MillCAM

Designer, insert your "Registration" floppy disk when prompted.
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Installation Procedure - Windows 95/98/NT

The MillCAM Designer 2

icon looks like this.

The MillCAM Designer Projects

icon looks like this.

It is recommended that

you allow the Denford

installation program to

create its own

directories and set up its

default values.  If you

find these inconvenient,

then feel free to alter

them.

  Note - x

5) Select the correct type of installation from the two choices;

"Standard", for stand-alone computers, or "Network", for multiple

computers linked together by a network.

Select the area of your hard-disk where the program files can be

installed, together with any program and folder names.  Network

users can find additional installation instructions on pages 50-51

of your main "MillCAM Designer 2 User Manual".

6) Your computer must be restarted before using MillCAM Designer

for the first time.

Ensure that keyed versions of the software have the dongle fitted

to the parallel port of your computer.  Your parallel port may be

labelled as the "printer" port and is usually positioned on the back

panel of your computer.

If you did not receive a dongle, you will be using a flash version of

the software (in which case your details would have been

registered via floppy disk in section 4).

To uninstall MillCAM

Designer, click "Windows

Startbar | Settings |

Control Panel | Add/

Remove Programs",

then highlight "Mill Cam

Designer" and click [OK].

  Note - x
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Quickstart
This section will enable you to become familiar with the features of

MillCAM Designer 2, without referring to the reference sections.

1) Start MillCAM Designer 2 by double clicking on the MillCAM icon,

or by clicking "Startbar|Programs|Denford|MillCAM Designer"  in

Windows 95/98/NT.  If the program does not open, check that your

dongle is correctly installed in the parallel port of your computer.

2) The materials window allows you to select the material type, CNC

machine tool type, the units of measurement and the dimensions

of the billet.

Change the machine type by clicking on the arrow to display the

dropdown list, then highlight and click on the appropriate machine

name and units of measurement.

Carry out the same procedure for selecting the material type.

Change the billet size values by clicking on the up and down

nudge buttons, next to the appropriate value.

Click the [OK] button to proceed.

Selecting the machine name and units of

measurement from the Materials window.

The MillCAM Designer

2 icon looks like this.
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Quickstart

Note - the order and

direction that you place

elements will eventually

be the order and

direction in which they

will be machined.

Therefore, it is very

important to think

carefully about what

your design will look like

when finished, so you

can plan the most

efficient toolpath, with

minimal tool changes.

  Tip - x 3) You will now be presented with the design window.  The large

rectangle with the grey grid represent a plan view of your billet -

this is the work area, where your design is drawn.  The buttons on

the left hand side are used to select the different types of

elements, used for building your design.

To select a shape element, click on the appropriate button, then

move your cursor into the work area.  Click and hold down the left

mouse button at the required starting point, then drag out the

required element shape, until the desired shape is achieved.

Release the left mouse button to confirm the end position of the

element.

Begin to build up your design, using the different elements

available.  Refer to the data panel, above the work area, for

detailed co-ordinate positions, cutter size and depth of cut

settings.

Once a part of an

element has been

deleted, it cannot be

recovered.

  Note - x 4) Elements can be deleted by clicking the right mouse button.  This

will remove element parts one at a time, the most recently drawn

being the first deleted.

5) To delete an entire drawing, select the "New" option from the "File"

menu.

Element buttons. Work area.
Your design is

constructed  within the

Design window.

Data panel.
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Quickstart

The cut and copy

commands place the

selected elements into

the computers memory,

where they stay until

another element is cut

or copied.  This allows

the paste command to

be used to make

multiple copies.

  Tip - x

6) Left clicking on the "Edit" button will allow you to select a number

of elements.  Move onto the work area, then click and hold down

the left mouse button.  Stretch a marquee (a dashed lined box)

completely around all the elements you want to select.  Elements

that you select are always highlighted in black.

7) Selected elements can be moved around by choosing the "Cut"

option from the "Edit" menu, followed by "Paste", also from the

"Edit" menu.  The "paste scale" window that appears allows the

size of the pasted elements to be altered.  Leave this set to 1 if no

change is needed, then click on [OK] to proceed.  Finally position

the elements in their new place and left click to confirm their

position, or right click to permanently delete these elements.

8) Any selected elements can be duplicated by repeating section 7,

but choosing "Copy" instead of "Cut", from the "Edit" menu.

9) Different cutting depths are achieved using the "Depth" button.

Different depths are shown in the work area using different

colours.  Using the "Set Cutter Depths" window, click the diamond

marker next to the depth you require, then click the [OK] button.

All subsequent elements will be placed at the new depth.

Marquee used to select elements. Selected elements are shown in black.

Use the Depth button to select new

cutting depths.  The black diamond

marker shows the currently selected

depth.  The tickmark shows depths

already in use.

Cutting and pasting can

redefine the order of

machining.  Any new

pasted elements

become the last objects

placed and therefore the

last elements machined.

  Note - x
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Quickstart
10) Different sizes of tool are selected using the "Cutter" button.

Using the "Change Tool Diameter" window, click the diamond

marker next to the cutter size you require, then click the [OK]

button.  All subsequent elements will be placed using the chosen

cutter size.

11) When your design is complete, save the MillCAM Designer 2 file

using the "Save As" command from the "File" menu.  MillCAM

files are saved in MCD format.

12) To produce a G-code file, the language understood by CNC

machines, use the "Make file..." command from the "Create G-

code" menu.  All that remains is to transfer this file to your CNC

machine for parts manufacture!

Most CNC machines

are different in the way

they read or load G-

code instructions.

Therefore no specific

instructions can be

given within this

manual.  Please check

the machine

manufacturer's manual

for exact details.

  Note - x

Filenames must be no

longer than eight

characters.

  Note - x

Tool change operations

require large amounts of

time on a CNC machine

tool.  Try to plan your

design so tool changes

are kept to a minimum.

  Note - x

Use the Cutter button to

select a new size of

cutting tool diameter.

The black diamond

marker shows the

currently selected cutter.
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Material Window

Material type

dropdown list button.

Units of

measurement

display checkbox.

Billet height

nudge buttons.

Machine type

dropdown list button.

[OK] and [Default]

settings buttons.

Billet width nudge

buttons.

Billet length nudge

buttons.

The material window is the first window displayed when the MillCAM

Designer 2 program is started.

The term Billet refers to the piece of material that will be machined.

  Jargon Buster - x
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Various options are available in the material window:

1) Machine Type - Click the arrow button next to the "Machine Type"
title to display the dropdown list, then click on the name of the
machine you intend using for parts manufacture.

2) Units of Measurement - A tickmark in the "Metric Units"
checkbox indicates Metric measurement (millimetres) are
selected.  No tickmark indicates Imperial measurement (inches).
Note that this checkbox is only used for display purposes - The
Units of Measurement are set from the options in the "Machine
Type" dropdown list.

3) Material Type - Click the arrow button under the "Material Type"
title to display the dropdown list, then click on the name of the
material used for your billet.

Note - Selecting a particular material will load a specific machining
parameters file.  These files can be edited from the design
window, using the "Create G-code|Set G-code parameters..."
menu.  The units of measurement used in the machining
parameters file must match the units of measurement used in the
machine type (chosen in section 1), i.e. they must be both Metric
or both Imperial.

For more information see the G-code Parameters and Advanced
setup sections on pages 39 and 46.

4) Height - Click the up and down nudge buttons to define the
"height" of the billet in the units of measurement previously
selected.  This will be the Z axis movement of the machine.

5) Width - Click the up and down nudge buttons to define the "width"
of the billet in the units of measurement previously selected.  This
will be the Y axis movement of the machine.

6) Length - Click the up and down nudge buttons to define the
"length" of the billet in the units of measurement previously
selected.  This will be the X axis movement of the machine.

7) OK / Default - Click the [OK] button to save the current settings
and open the design window.  Click the [Default] button to reset all
the options in the materials window.

Material Window

A Parameter  is a value contained in a program.  Many of these parameter values

can be changed by the software user.

  Jargon Buster - x
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Design Window

Titlebar. Menubar. Data panel.

Work area.Element buttons.

Work area.

This is the area where the design is constructed, using the element
buttons to the left of the display.  The working area represents a plan
view of the billet (i.e. its length and width), with the depth of cut
indicated by the colours used on the element lines.

Menubar.

Click the required menu title to display the dropdown list.  Move the
cursor down the list, highlighting each option.  Click the highlighted
option to select it.

Titlebar.

The titlebar shows the name of the program "Mill CAM Designer 2"
along with the name of the file currently being edited (if saved
previously).

Data Panel.

The data panel provides a continuously updated read-out of useful
information, including current co-ordinate position, depth of cut,
diameter of the machine cutter and grid size.

The design window is displayed following material set-up.  This is

the main program window where designs are built up.
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Element buttons - Line
Several simple shapes, or elements, can be drawn in Mill CAM

Designer 2.  They are accessed by clicking on the element buttons

down the left hand side of the design window.  A red light is shown

when a button is selected.

Note - the order and direction that you place elements in the work

area will be identical to the order and direction in which they will be

machined.  Therefore, it is very important to think carefully about

what your design will look like when finished, so you can plan the

most efficient toolpath, with minimal tool changes.

[Line]

Straight lines are added by selecting this button.

Click and hold down the left mouse button at the starting point of the

line, then drag the line out and release the mouse button when the

end point is reached.
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Element buttons - Arc

Click  the up and down arrows nudge buttons to change the angle of
the drawn arc.  You can also change the arc direction by selecting
the clockwise or anticlockwise diamond markers.  Click the [OK]
button when you are ready to proceed.

Click and hold down the left mouse button at the starting point, then
stretch out the arc to the finishing point,  releasing the mouse button
when you have finished.

If you click the right mouse button the while dragging the arc, the
direction of the arc will reverse.

The arc angle can be changed using the keyboard [up and down
arrow] keys.  To change the arc angle in smaller increments, hold
down the [SHIFT] key whilst pressing the [up and down arrow] keys.

[Arc]

Curved lines are added by selecting this button.

Click anywhere in the work area.  The "Set Arc Angle" window will
appear.
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Element buttons - Frame, Box

[Frame]

Straight lined frames are added by selecting this button.

Click and hold down the left mouse button at the starting point of the

frame, then drag out the frame to the required size.  The data panel

shows the distance between opposite corners.  Release the left

mouse button to finish the operation.

[Box]

Straight lined boxes, called pockets, are added by selecting this

button.  All the material within the perimeter of the box will be

machined to the selected depth.

Click and hold down the left mouse button at the starting point of the

box, then drag out the box to the required size.  The data panel

shows the distance between opposite corners.  Release the left

mouse button to finish the operation.
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Element buttons - Circle, Ring

[Circle]

Circular pockets are added by selecting this button.  All the material

within the perimeter of the circle will be machined to the selected

depth.

Click and hold down the left mouse button at the desired centre point

of the circle, then drag the circle outwards to the required size.  The

data panel shows the circle radius.  Release the left mouse button to

finish the operation.

[Ring]

Circular frames are added by selecting this button.

Click and hold down the left mouse button at the desired centre point

of the ring, then drag the ring outwards to the required size.  The

data panel shows the ring radius.  Release the left mouse button to

finish the operation.
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Element buttons - Text

[Text]

Strings of alphanumeric characters are added in your design by

selecting this button.

Click anywhere in the work area.  The "Text Input" window will

appear.

The cursor will be flashing in the "Input text" dialogue box.  Type the

text required into this box.

continued....

Input text

dialogue box.

Character

width nudge

buttons.

Character

height nudge

buttons.

Character

spacing nudge

buttons.

[OK] and [Cancel]

text operation

buttons.

[Fonts]

selection

button.

Name of currently

selected font.

Mirror image

checkbox.

Text orientation

checkboxes.
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Element buttons - Text
The height, width and spacing of the letters can be changed by
clicking on the appropriate up and down arrow nudge buttons.

Character spacing allows the distance between each individual
character to be increased or reduced, useful when trying to stretch a
word to fit a specified space.

The direction of the text can be specified by clicking in one of the
four text orientation checkboxes.  A tickmark shows the selected
orientation.

A mirror image can be produced by clicking the checkbox next to the
mirror picture.  A tickmark is displayed when this option is selected.

Select the font style by clicking the "Fonts" button, then load the
required font, file extension ".fnt".  Available fonts are shown below:

Click the [OK] button to proceed.

The "Paste Scale" window will appear.  To fit the text into the work
area at its largest possible size, use the maximum scale value
suggested in the "Paste Scale" window.  For scale 1:1 use a value of
1.000.  Click the [OK] button after entering a value.

Move the text to the required position and click the left mouse button to
place the text in your design, or the right mouse button to discard it.
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Element buttons - Edit

[Edit]

Elements can be selected, moved and deleted using this button.

Editing can be performed using several methods:

1) Click on the [Edit] button, then click and hold down the left mouse

button in the work area.  Drag the marquee box completely

around the required elements to select them.  Selected elements

are always coloured black.

To reposition the selected elements:

Click the right mouse button to lift the selected elements from the

design.  Reposition the elements and click the left mouse button

to replace them in their new position.  Repositioning elements can

redefine the order of machining - the last elements placed become

the last elements machined.

To delete the selected elements:

Click the right mouse button to lift the selected elements from the

design.  Click the right mouse again, to delete them.  Note - once

an element or a part of an element has been deleted, it cannot be

recovered.

2) Click on the [Edit] button, then click the right mouse button in the

work area.  Each right mouse button click cycles through

individual element parts in turn.  Delete the selected element part

using the left mouse button.

Click "Edit|Select All"

from the menubar to

highlight all the

elements on the screen.

  Tip - x

A marquee box is a box shown using dotted lines.  It is dragged completely around

a set of elements to select them.

  Jargon Buster - x

To select multiple

elements, hold down the

[CTRL] key whilst

clicking on each

element in turn.  This

selection can also be

grouped together using

the "Advanced | Group"

menu command.

  Tip - x
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Element buttons - Step
[Step]

To enable a high degree of accuracy in Mill CAM Designer 2,

elements are drawn and positioned using increments, called steps.

The [Step] button allows this increment value to be adjusted.

Clicking the [Step] button will display the "Change Step Size"

window.
[OK] and [Cancel] step

operation buttons.

Grid Lock checkbox.

Step size nudge

buttons.

Use the up and down arrow nudge buttons to change the size of

step.

Click in the "Grid Lock" checkbox to limit movement to the

intersections of the grid lines only.  A tickmark appears when this

option is selected.

Click the [OK] button to accept the changes made, or the [Cancel]

button to discard them.
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Element buttons - Cutter
[Cutter]

Different diameter cutting tools are selected using this button.

Clicking the [Cutter] button will display the "Change Tool Diameter"

window.

Mill CAM Designer 2 allows a range of twelve cutter sizes to be

used.  A black bullet is displayed to indicate the currently selected

cutter.  Click the grey diamond marker to the left of the cutter size

title you require.

Click the [OK] button to change to the new tool diameter, or the

[Cancel] button to discard any changes.

Any elements you place in the work area will now be drawn (and

subsequently machined) using this new diameter cutter.

Note - the current cutter size is always shown in the grey data panel,

under the menubar.

If you intend using more

than one tool diameter,

try to draw all the

elements you need with

each tool before

changing to another

size.  Remember,

changing the cutter is

time consuming, so try

to keep changes to a

minimum.

  Tip - x

Details about how to

define new tool settings

are given later in the

Reference Section.

  Note - x
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Element buttons - Depth
[Depth]

The depth of cut can be changed by selecting this button.

Clicking the [Depth] button will display the "Set Cutter Depth"

window.

To select a new depth, click on the grey diamond marker, next to the
coloured square.  A black diamond bullet shows the depth currently
selected.  Click the [OK] button to accept the changes made.

The grey squares to the left of each "Start of line depth" value
display a tickmark if the indicated depth is being used on any part of
the design.

It is possible to cut lines with different start and finish depths.  An
error message will appear if the depth of cut exceeds the material
depth, or the maximum depth allowed for the tool bit that is in use.

Mill CAM Designer 2 has the added advantage of having 16 preset
depths. Depths are in increments of 0.5 to give the user greater
flexibility.

Individual depth values can be edited by clicking the cursor inside
the appropriate depth value dialogue box, then overtyping with the
new depth value.  This feature allows gradient depths to be set.

When the finishing depth of a cut is at a different height to the start
depth, a coloured gradient is shown along the length of the cutting
line.  The start of line depth always corresponds with the starting
point of the element, allowing control over gradient direction.

Depth in use

checkbox.

Starting depth

dialogue box.

Finishing depth

dialogue box.

Currently selected depth

diamond bullet.

[OK] button.
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File Menu

Click the "File" menu title to display the dropdown list.  Move the
cursor down the list, highlighting each of the eleven options.  Click
the highlighted option to select it.

"New"

Click this option to start a new design.  The screen is cleared after
giving you the option to save any previously designed work.

Shortcut keys [Ctrl + N].

"Open..."

Click this option to open a previously saved MillCAM Designer 2 file.
Choose the directory and folder from the "Directories:" box, select
the ".mcd" filename from the "Files:" box, then click the [OK] button
to load the file.

Shortcut keys [Ctrl + O].
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File Menu

"Save Project..."

Click this option to save a collection of program variables as a
project template.  The facility enables the software to be tailored to
individual needs.  Variables such as billet size, machine type,
material type, maximum machining time, depth of cut, step size, grid
size and cutter diameter can be set.  When a project template is
open, variables can be edited by pressing [Alt + S] to access the
"Setup System File" window.

Click the arrow button next to the project title to display the
dropdown list, then select the title of the required project.  Click the
[OK] button to save the current MillCAM Designer program variables
as the selected project title.

Previously saved project templates can be accessed by clicking the
"Projects" icon, found in the "Denford" group, then selecting the
required title from the dropdown list.

See page 47 for more information about Advanced Program Setup.

"Save"

Click this option to update the changes made to a previously saved
MillCAM Designer 2 file.  MillCAM Designer 2 files are saved using
the file extension ".mcd".

Shortcut keys [Ctrl + S].

"Save As..."

Click this option to save the current MillCAM Designer 2 file with the
option to place the file in a specific directory and folder with a user
defined filename.  Choose the directory and folder from the
"Directories:" box, type the name of the file in the "Filename:"
dialogue box, then click the [OK] button to save the file.  Filenames
must not be longer than eight characters.
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File Menu

Below: DXF Import Example.

Minimum line length = 1. Minimum line length = 4.

"Import DXF File"

A file from a another design package can be placed into MillCAM
Designer 2 using the DXF (Data eXchange Format) standard.

The imported image can be altered by using the "Minimum Line
Length" dialogue box.  The value entered determines the minimum
length of the straight lines which make up the image.  The default
value is 1mm.  A higher number reduces the amount of detail which
is shown.  Less detail means the image can be milled faster.

Click the [OK] button to proceed.  The "Paste Scale" window will
appear.  To fit the image into the work area at its largest possible
size, use the maximum scale value suggested in the "Paste Scale"
window.  For scale 1:1 use a value of 1.000.  Click the [OK] button
after entering a value.

Move the image to the required position and click the left mouse
button to place the image in your design, or the right mouse button
to discard it.
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"Print"

Click this option to print the work area of the design window.  The
appearance of the printed design can be changed by clicking in the
various checkboxes.  The [Setup] button accesses the "Print Setup"
window.  Click the [Print] button to begin printing.

Shortcut keys [Ctrl + P].

"Change Font"

Click this option to change the typeface used, when adding text into the
work area.  Click on the name of the required font, then the [OK] button
to continue.  A list of the available fonts are shown on page 23.

"Alter Material Size"

Click this option to display the material window, where the billet size
can be changed.  Note - all data will be lost unless saved before
selecting this option.

"Exit"

Click this option to close the MillCAM Designer 2 software.  The
program is closed after giving you the option to save any previously
designed work.

"Printer setup"

Click this option to select and configure your printer options.

File Menu
"Export DXF File"

Click this option to save the contents of the working area, using the

DXF (Data eXchange Format) standard.
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Edit Menu

Click the "Edit" menu title to display the dropdown list.  Move the

cursor down the list, highlighting each of the ten options.  Click the

highlighted option to select it.

"Cut"

Click this option to remove any selected elements from the work

area to an area of the computer memory called the Windows

clipboard.

Shortcut keys [Shift + Del].

"Copy"

Click this option to place a duplicate of any selected elements into

the Windows clipboard, leaving the originals untouched in the work

area.

Shortcut keys [Ctrl + Ins].

"Paste"

Click this option to place any cut or copied elements into the work

area.  The "Paste Scale" window will appear.  To fit the elements into
the work area at their largest possible size, use the maximum scale
value suggested in the "Paste Scale" window.  For scale 1:1 use a
value of 1.000.  Click the [OK] button after entering a value.

Move the new elements to the required position and click the left
mouse button to place the new elements in your design, or the right
mouse button to discard them.

Shortcut keys [Shift + Ins].
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Edit Menu
"Paste Special..."

Click this option to place any cut or copied elements into the work

area with a greater degree of control.  This option works in exactly
the same way as "Paste", but in addition gives the choice of
changing the depth of cut and/or cutter diameter used on the
elements.

Using "Copy", then "Paste Special..." elements can be overlaid
progressively in identical positions, but with different depths of cut.
This allows deep cuts to be performed in stages, without stressing
the cutting tool.

"Mirror..."

Click this option to flip over selected elements.

Click the grey diamond markers to select between "Vertical" and

"Horizontal" mirroring.  A black bullet indicates the current selection.

Click the "Leave original" checkbox to indicate whether the original

elements should be left in the work area (tickmark visible) or

permanently removed (tickmark not visible).

Click the [OK] button to perform the mirror operation.

Shortcut keys [Ctrl + M].
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Edit Menu

"Copy to..."

Click this option to save the currently selected elements as a Mill

CAM Designer 2 file, allowing a library of commonly used parts to be

built up.

"Paste from..."

Click this option to import other previously saved Mill CAM Designer

2 designs or parts into the current work area.

"Select All"

Click this option to select all the elements in the work area.

Shortcut keys [Ctrl + A].

"Refresh Screen"

Click this option to redraw the design window.  This is commonly
required after performing a "cut" command.

Shortcut keys [Ctrl + F].

"Rotate..."

Click this option to turn selected elements by a specified number of

degrees.

Click the up and down arrow nudge buttons to specify the angle of

rotation.

Click the "Leave original" checkbox to indicate whether the original

elements should be left in the work area (tickmark visible) or

permanently removed (tickmark not visible).

Click the [OK] button to perform the rotate operation.

Shortcut keys [Ctrl + R].
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Grid Menu

Click the "Grid" menu title to display the dropdown list.  Move the

cursor down the list, highlighting each of the eight options.  Click the

highlighted option to select it.

"Grid to (number) mm"

There are five preset grid sizes, the lines shown behind the design in

the work area.  They are 5, 10, 15, 20 and 25mm.  A tickmark is

shown next to the currently selected option.  Click the required grid

title to select the new grid size.

"Grid OFF"

Click this option to completely remove the grid lines from the work

area.

"Custom..."

Click this option to set the grid with a user defined value.  Note - this

value should not be too extreme (i.e. too small or too large).

"Grid Colour"

Click this option to

display a sub menu

of eleven colours

that can be used on the grid lines.

Highlight and click a colour to select it.

The default colour for the grid lines is the

last option, grey.
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Advanced Menu

The "Advanced" menu can be displayed or hidden from the

menubar, according to the requirements of the user.  The default

setting is hidden.

If the "Advanced" menu is hidden, press your keyboard [Alt + S]

buttons to display the "Setup System File" window.  Click inside the

"Show Advanced Menu" checkbox, so a tickmark is displayed

(shown below).  Save any work, then restart the MillCAM Designer

program.  The "Advanced" menu will now be displayed.
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Advanced Menu
Options available:

"UnDelete"

Click this option to place the last deleted element back into its

original position in the working area.  If a number of elements have

been deleted, each one can be recovered in sequence, using this

option.

Shortcut keys [Alt + BkSp].

"Group"

Highlight a number of individual elements, then click this option to

group them together as one large object.  When a marquee box is

drawn around any element belonging to a group, all the associated

elements in that particular group are automatically selected.

Note: When text characters are drawn, the elements used to

compose each character are automatically grouped upon creation of

the text character.

"UnGroup"

Click this option to separate a selected group into its individual

elements.

"View Group IDs"

Click this option to view the current groups present in the working

area.  Each group is defined by a number.  This group number is

displayed on each element that belongs to the group.

Click the "View Group IDs" menu text to switch the option on (a

tickmark is displayed) or off (a tickmark is not displayed).

Above: Two groups are shown in this screenshot:

group 1 (on the right) and group 2 (on the left).
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Advanced Menu
"Attach"

When this option is switched on, the start point of any new element

you draw is automatically snapped to the end point of the element

nearest to your cursor.

Click the "Attach" menu text to switch the option on (a tickmark is

displayed) or off (a tickmark is not displayed).

The sensitivity of the "Attach" command can be adjusted using the

"Attach Tolerance" option, in the "Setup System File" window (menu:

"Advanced|Settings").  This defines the size of the snap-to line

boundary in pixels.

"Lock Axes"

When this option is switched on, the start and end points of any new

elements can only be positioned horizontally or vertically within the

working area.

In other words, once you place the start of an element, you can only

draw along the directions of the X and Y axes.

Click the "Lock Axes" menu text to switch the option on (a tickmark

is displayed) or off (a tickmark is not displayed).

"Settings"

Click this option to display the "Setup System File" window (shown

at the bottom of page 37).

Above: "Lock Axes" switched off.

Elements can be positoned at any angle.
Above: "Lock Axes" switched on.

Elements can only be positioned

horizontally and vertically.
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Create G-code Menu

Click the "Create G-code" menu title to display the dropdown list.
Move the cursor down the list, highlighting each of the two options.
Click the highlighted option to select it.

"Make file..."

Select this option to convert your MillCAM Designer 2 design into a
G-code file, a series of letters and numbers that make up the
language used by CNC machine tools.  G-code files are saved using
the file extension ".fnc".

The "File Save As" window will appear.  The default path is
"c:\denford\data". Choose the directory and folder from the
"Directories:" box, then type the name of the file in the "Filename:"
dialogue box.  Filenames must not be longer than eight characters.
Click the [OK] button to begin the conversion process.

The "G Code Generator" window will be displayed, showing a
confirmation of the chosen filename and location.

The "Convert Arcs to Lines" checkbox is used to change any Arcs
drawn into a series of straight lines.  This allows the CNC machine
to generate arcs with very large radii.  It can also  be used to prevent
mathematical errors occurring, such as when a "Bad Arc End"
message appears when machining.  MillCAM Designer 2 will
automatically convert any arc with a radius of greater than 130mm to
lines.

Click the "Convert Arcs to Lines" checkbox to indicate whether the
arcs should be converted (tickmark visible) or not converted
(tickmark not visible), then click the "Create G-code" button.
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Create G-code Menu

The "G-Code Timing" window will be displayed, showing an
indication of the time required to manufacture the design.  If the
indicated time is larger than the maximum machining time allowed
(set in the "Setup System File" window - press [Alt + S] ), the G-
code file will not be produced.

Click the [OK] button to begin converting a valid design into G-code
files.

Right: The G Code
Generator window.
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"Set G-code parameters..."

Select this option to configure a machining parameters file, by

clicking on the appropriate nudge buttons, diamond markers and

dropdown lists.  Individual files are saved according to the material

being machined - each file contains all the speed and feed values

required to safely machine a specific billet material using a range of

different sized cutting tools.

Create G-code Menu

A Parameter  is a value contained in a program.  Many of these parameter values

can be changed by the software user.

  Jargon Buster - x

[OK] and [Cancel]

machine tool

parameters buttons.

Add new

material button.

Cutter machining

parameter nudge buttons.

Cutter selection

diamond markers.

Material type

dropdown list button.

[Load], [Save] and [Default]

machine tool parameters

buttons.
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Create G-code Menu
"Cutter Diameter"

To select a cutter diameter, click on the grey diamond marker, next
to the appropriate cutter diameter value.  A black diamond bullet
shows the cutter diameter currently selected.  Any previously saved
speed and feed values, used with this cutter diameter and the
selected material, will automatically load.  For new cutter diameters
used with the selected material, adjust the machining parameter
values as required.

"Machining Parameters"

Click the up and down arrow nudge buttons to specify the value of
the following machining parameters, appropriate to both the cutter
diameter and the type of material selected:

• Cutter Speed, in RPM (revolutions per minute).
• Cutter Maximum Depth of cut, in mm.
• Cutter X and Y feedrate, in mm/min.
• Cutter Z feedrate, in mm/min.

"Material option"

The material option loads machining parameters appropriate for both
the material chosen and all cutter diameters specified.  Click the
arrow button next to the name of the material to display the
dropdown list, then click on the name of the material you intend
using for parts manufacture.

You can specify your own material by clicking on the [Add...] button,
then typing a name for the new material.  Adjust the machining
parameter values for each cutter diameter as required.

Click the [Save] button to save any changes made to the machining
parameters.  By default, the machining parameters files are saved to
the path "c:\denford\uconfig", using the ".fsf" file extension.

Any material selected or added will be used as the default in the
"Material" window, the next time the MillCAM Designer 2 software is
run.  For more information see Advanced setup on page 46.

"Export to VR Milling"

Click this option to create a G-code file, then automatically load the
file into the Denford VR CNC Milling software package.  This feature
is only enabled when VR CNC Milling is running and requires
version 2.90 or above of Denford VR CNC Milling.

The machining

parameter values

entered must be defined

in the same units of

measurement (i.e.

Metric or Imperial) as

those chosen from the

"Machine Type"

dropdown list in the

material window at the

start of the program.

  Note - x
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Help Menu

Click the "Grid" menu title to display the dropdown list.  Move the

cursor down the list, highlighting each of the eleven options.  Click

the highlighted option to select it.

"About MillCAM Designer"

Click this option to display information about the MillCAM Designer 2

software:

• Software version number.

• Language installed.

• Units installed.

• Dongle / Flash code serial numbers.

Click the [OK] button to close the window.
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Help Menu
Help Screens

Help hints can be displayed for each of the listed topics.  To close

the Help Screens, click the [OK] button.
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Pressing the keyboard [Alt + S] keys will display the "Setup System
File" window.

"Custom G-code Set up"

When a G-code is produced, these defaults are automatically set by
the MillCAM Designer 2 program.  Click the up and down arrow
nudge buttons to specify their values.

• "Stand off height" - The working height above the billet.  The cutter
will travel to this height before rapidly moving to a different
location.  The stand off height can be increased to work around
any raised part of the billet.

• "Step size for pocket cycles" - The depth that each pocket cycle
will descend until it reaches the required depth.  For example, if
the value is set to 1.00mm and a 4mm pocket is required, the
program will cycle down in 1mm decrements until the 4mm level is
reached.

• "Maximum Machining Time" - The maximum time allowed for
machining any part in MillCAM Designer 2, specified in minutes.
When making a G-code file, the program will not allow parts that
take longer than this value to be manufactured.  The design must
be edited so it takes less time to manufacture.

• "Show Machining Time" checkbox - Used to switch the "Maximum
Machining Time" feature on (tickmark shown) and off (tickmark not
shown).  Click inside the checkbox to display or remove the

tickmark.

continued....

Setup System File Window
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Setup System File Window
continued....

"Start-up Defaults"

When the MillCAM Designer 2 software is started, these values will
apply. Click the up and down arrow nudge buttons to specify their
values.

• "Grid Size" - Work area background grid size, in mm.
• "Step size" - Element placement step accuracy, in mm.
• "Attach Tolerance (in pixels)" - Adjusts the sensitivity of the

"Attach" command by defining the size of the snap-to line
boundary, in pixels.  The "Attach" command is accessed from the
"Advanced" menu (when available).

• "Cutter Diameter" - The diameter of the cutting tool, in mm.
• "Cutter Depth" - The maximum depth of cut for the cutter selected, in mm.
• "Show Advanced Menu" checkbox - Displays (tickmark shown) or

hides (tickmark not shown) the "Advanced" menu, on the main
program menubar.  Click inside the checkbox to display or remove
the tickmark.
Security Issue: To prevent unauthorised direct access to
advanced MillCAM features, such as grouping or the "Setup
System File" window, we recommend this option be left
unchecked.

Click the [OK] button to apply the new settings, or the [Cancel]
button to discard any changes.

When changes are

made to the "Show

Advanced Menu",

MillCAM Designer

MUST be shutdown,

then restarted, in order

to view their effect.

  Note - x
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Direct Data Entry

MillCAM Designer 2 allows elements to be placed or edited in the
work area manually, using known co-ordinate and measurement
values.  This feature applies to the Line, Arc, Frame, Box, Circle and
Ring elements.

To place a new element manually - Click the appropriate element
button, then move the cursor into the work area and press the
keyboard [Enter] key to display the "MDI (Manual Data Input)"
window.  The name of the element being placed will be stated in the
"Object Type:" box and the "NEW OBJECT" diamond marker will be
checked with a black bullet.  Enter the Start X and Y co-ordinates in
the left box and the End X and Y co-ordinates in the right box.  Use
the Design window "Data Panel" to help find co-ordinate values.
The lower box contains arc angles, circle radius values and CW or
CCW directions, when relevant.  The Depth of cut can also be
specified by clicking on the [Depth] button.  Note - the "MDI" window
options and layout will vary according to the element being placed.
Click the [OK] button to confirm the "MDI" information and click the
left mouse button to place the element, or the right mouse button to
discard it.

To edit an existing element manually - Select the element to be
edited, then press the keyboard [Enter] key to display the "MDI"
window.  The name of the element that can be edited will be stated
in the "Object Type:" box and the "NEW OBJECT" diamond marker
will be unchecked.  Edit the existing element values and parameters,
then click the [OK] button to apply these changes.  Note - the "MDI"
window options and layout will vary according to the element being
edited.

Manual Data Input for a new element. Manual Data Input for an existing element.
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Position and purpose of the main MillCAM

Designer 2 files.

Program Structure
MillCAM Designer 2 uses and creates several files while it is

running.  The diagram below shows the position and function of

these files.

Config Directory

Denford Directory

MACHDATA.INI

Holds the path data

for various types of

milling machines

MC-DES2.EXE

Main Executable

file

DENLANG.DLL

Post processor

program that

generates G-Code

FANUCL.INI

Individual settings

for different lathes

Libs Directory

FANUCL.SLB

Information for

creating G-Code

specific to CNC

milling machine

MCD2.INI

Start up values for

main program.

Data

Directory

GENERIC.GNC

Generic G-Code

file, created by

MillCAM for use by

DENLANG.DLL
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Advanced Program Setup
All of the program features are setup automatically by

the installation program.  It is possible to alter some

program settings manually, to suit your particular needs.

The program default values are stored in the "MCD2.ini"

file.  This can be found in your Denford directory.  The

following is an example of this file and a description of

the contents.

[Material Size]

Length=160.00

Width=90.00

Height=10.00

Max machine time=10

Machine=Novamill (metric)

File=c:\denford\data\test.mcd

Material = Steel

Complex=1

Tool number=1

Real Tool Diameter = 1

Language = English

NFM=1

Step=5

Grid=10

Tool=2

Depth=1mm

[Materials]

Steel=C:\DENFORD\UCONFIG\STEEL.FSF

Aluminium=C:\DENFORD\UCONFIG\ALI.FSF

High Density Polystyrene=C:\DENFORD\UCONFIG\H_POLY.FSF

Acrylic=C:\DENFORD\UCONFIG\ACRYLIC.FSF

Wood = C:\DENFORD\DATA\WOOD.FSF

[Path Data]

GNC Name=C:\DENFORD\DATA\GENERIC.GNC

Font Files=C:\DENFORD\FONTS\STRAIGHT.FNT

MCD Files=C:\DENFORD\DATA\

DXF Files=C:\DENFORD\DATA\

GCode Files=C:\DENFORD\DATA\

Feeds Files=C:\DENFORD\UCONFIG\

Project Files=C:\DENFORD\UCONFIG\Project.ini

[Advanced]

Show Time=1

Show Advanced Menu=1

Attach Tollerance=50

[Tool1]

tools maximum depth=2.00

tools rotational speed=3000

tools XY Feedrate=150.00

tools Z Feedrate=100.00

[Tool2]

tools maximum depth=2.00

tools rotational speed=3000

tools XY Feedrate=150.00

tools Z Feedrate=100.00

[Tool12]

tools maximum depth=12.00

tools rotational speed=1500

tools XY Feedrate=150.00

tools Z Feedrate=100.00
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Advanced Program Setup
The following section explains the parameters listed from the "MCD2.ini" file shown on the previous page:

[Material size]

Length: Most recently used material length.

Width: Most recently used material width.

Height: Most recently used material height.

Max machine time: Sets the maximum milling time for

each g-code program (ie, very

complex designs must be simplied to

allow g-codes to be  generated).

Machine: Most recently used machine type.

This is also used to find machine

defaults by looking up the name in

the file "Machdata.ini", in the

"Denford" directory.

File: Directory path of the millcam

designer (.mcd) file.

Material: Most recently used material.

Complex: Gives the option to turn off complex

graphics.  When a 1 is present,

pasting an object will show the detail

of the pasted object.  If a 0 is used,

then only a dotted rectangle will be

shown, more beneficial for slower

computers.

Real Tool Diameter:Tells the program whether it should

draw rubber banded objects in their

real diameter.  This may set to 0 if

on a slower computer.

Language: To be used for other language

conversion.  By default, the value is

set to 0.

NFM: Used to disable the "Set G-Code

Parameters" menu.  This menu

option can still be called by pressing

the keys [Alt + Ctrl + ?].  A value of

1 will disable the menu, a value of 0

will allow the menu to be displayed.

Step: Stored default value of the step in

mm.

Grid: Stored default value of the grid in

mm.

Tool: Default number for start-up tool

diameter in mm.

Depth: Selects the colour of the depth that

is set in the start-up default values.

[Materials]

Stores the names for a particular

material and the location of the file

containing the speeds and feeds.

[Path Data]

GNC Name: Name and directory where the

program will store the temporary file,

generated by MillCAM Designer 2,

used by the post- processing

program.

Font Files: Name and directory of the most

recent font to be used.

MCD Files: Directory where the latest MillCAM

Designer 2 (".mcd" format), file was

saved.

DXF Files: Directory from where the last data

exchange file was read.

GCode files: Directory where the finished G-Code

file was last saved.

[Advanced]

Show Time: 1 indicates machining time will be

used when generating g-codes; 0

indicates machining time will not be

used.

Show Advanced Menu:1 indicates the menu will be

displayed in the main program

menubar; 0 indicates the menu will

be hidden.

Attach Tolerance: Defines size snap-to line boundary

in pixels.

[Tool number]

Each tool has an area labelled

[Tool1] to [Tool12].  This data is the

information loaded as a default

when no other speeds and feeds

have been specified.

Save "Project.ini" variables:

Length: Maximum length of workpiece.

Width: Maximum width of workpiece.

Height: Maximum height of workpiece.

Machine: Specific machine used.

Max machine time: Time allowed for machining.

Depth: Maximum depth of cut.

Step: Step size required.

Grid: Grid size required.

Tool: Tool number.

File: Project template filename and

location.
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Advanced Program Setup
It is possible to lock the "MCD2.ini file by changing its attributes to

"read only" or by typing the DOS command Attrib +r MCD2.ini.

Using this procedure, no changes can be made to the file.  This can

be useful when running the software on a network or to prevent

unauthorised editing of the file by other users.

When starting the program, it is possible to disable both the logo

screen and the material size screen.  This is achieved by typing

either NL or NS respectively after the command line parameters

within the program properties box.

By typing the key word FEEDS after the command line parameters,

followed by the name of any saved feeds and speeds files, Mill CAM

Designer 2  will automatically load the specified feeds and speeds

file.

Summary of command line parameters:

NL or nl: No logo to be displayed.

NS or ns: No material size screen to be displayed.

FEEDS (filename): Loads a previously saved feeds and speeds

file ".fsf" format.

Shortcut command line parameters are entered here, at the end of the Target:

command line.  The example shown below would run MillCAM Designer 2 with no

logo or materials window at start-up.
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Technical Specification
Minimum computer specification to run Mill CAM Designer 2:

A PC compatible capable of running Microsoft Windows Version 3.1

or above.

Maximum number of drawing elements:

1650.

Maximum number of elements that can be stored in past memory:

1650.

Maximum number of tools:

12.

Maximum Tool Diameter:

12mm ( 0.5£ ).

Maximum number of depths:

16.

Saved File names extension:

.mcd

Set grid sizes available:

5, 10, 15, 20, 25mm  ( 0.25,0.5,0.75,1,1.25£ ).

DXF imports.

Mill CAM Designer 2  has been tested on the following software, to

ensure that DXF files can be imported without error:

• CorelDraw version 2

• CorelDraw version 3.

• CorelDraw version 4.

• Auto Sketch for DOS.

• Auto Sketch for Windows.

• Both Auto Sketch versions will retain arc formats when

transferring information.

• Worricad.

• Techsoft Designer.

• Design View 3.
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Network Installation of MillCAM Designer

To install MillCAM Designer 2 on your server computer:

Install the MillCAM Designer 2 software to the required hard drive on
your server computer.

Find the file "MCD2.ini", located in the "Denford" directory.

The "MCD2.ini" file contains a section similar to the following:

[Path Data]
GNC Name=P:\Denford\data\generic.gnc
Font Files=P:\Denford\fonts\straight.fnt.
MCD Files=P:\Denford\data\
DXF Files=P:\Denford\data\
GCode Files=P:\Denford\data\
Feeds Files=P:\Denford\uconfig\
Project Files=P:\Denford\uconfig\project.ini

where "P" is your server computer hard drive.

In addition to checking that these directories exist in the locations
listed, check that the following rules apply:
1) "GNC Name=" must point to a read/write file (it is a temporary file

created for each student during the G-Code generation process).
2) "MCD Files=" must point to a read/write directory (it is the

directory where a students design files are kept).
3) "G Code Files=" must point to a read/write directory (it is the

directory where a students CNC files are kept).
4) Workstation computers must have access to the main program file

"MCD2.exe" located in the "Denford" directory.

Normally, these three entries must be reconfigured to point towards
the students own personal directory area.  For example, a student
having a personal directory of "N:\Mywork\" would have these
entries changed in the server computer "MCD2.ini" file to read:

GNC Name=N:\Mywork\generic.gnc
MCD Files=N:\Mywork\
G Code Files=N:\Mywork\
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Network Installation of MillCAM Designer

To install MillCAM Designer 2 on each workstation computer:

Setup a shortcut to the main program file "MCD2.exe", located in the

"Denford" directory on your server computer.

Check that the "WIN.ini" file, located in the "Windows" directory, on

each individual workstation computer running MillCAM Designer 2

has the following:

[Denford Machine Tools]

Directory=P:\Denford\

where "P" is the Network drive mapped to the "Denford" folder on

your server computer.

For specialist networks (e.g. RM) contact Denford Customer

Services if you experience any problems.
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How To...

Selecting Multiple Elements:

Click the [Edit] button, then drag a marquee box around all the
elements required.  Elements will change black when selected.

Selecting an Individual Element:

Click the [Edit] button, then right click to cycle through each element
in the design.

Moving Elements:

1) Click the [Edit] button, then drag a marquee box around the
elements required.

2) Click the right mouse button once.  The elements will appear to
'float' above the work area.

3) Move the elements to the desired location, then click the left
mouse button once.

Resizing Elements:

1) Select the elements required.

2) From the menubar, click "Edit | Cut".

3) From the menubar, click "Edit | Paste".

4) The "Paste Scale" window will appear.  Enter the desired scale
value, then click [OK].

5) Position the elements, then place them by clicking the left mouse
button once.  Note - if elements are not the correct size, please
refer to the Cancel Element Placement procedure below.

Cancel Element Placement:

While the elements are still 'floating' above the work area, click the
right mouse button.  This will remove the elements.  This must be
done BEFORE placing any elements in the work area.

Removing Elements:

1) Select the elements required.

2) Click the right mouse button twice.

Quick Creation of a Drilled Hole:

1) Click the [Line] button.

2) Click once in the work area.  A drilled hole will be created
matching the diameter of the cutter (line thickness) used.
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How To...

Adding Text:

1) Click the [Text] button.

2) Move the cursor over the work area.

3) Click the left mouse button once.

4) A "Text Input" window will appear.  Enter and format the required
text, then click [OK].

5) The "Paste Scale" window will appear.  Enter a scale value and
click [OK].

6) Position the text, then place by clicking the left mouse button
once.

Adding a New Material Type:

1) From the menubar, click "Create G code | Set G code
Parameters".

2) The "Set Tooling" window will appear.  Enter the desired tool
settings.

3) Click the [Add] button.

4) Enter a name for the new material type, then click [OK].

5) Click [OK] in the "Set Tooling" window.

Changing the Maximum Machining Time:

1) Whilst using the design screen, press the [Alt] + [S] keys.

2) Increase or decrease the machine time.

3) Click the [OK] button to confirm the changes.

Changing the Cutter Settings:

1) From the menubar, click "Create G code | Set G code
Parameters".

2) Select the cutting tool to be changed.

3) Using the arrow keys, change the values assigned to the tool.

4) Click the [OK] button to confirm the changes.

Mirroring Elements:

1) Select the elements required.

2) From the menubar, click "Edit | Mirror".

3) Choose the required settings, then click [OK].

4) Enter a paste scale, then click [OK].

5) Position the elements, then place them by clicking the left mouse
button once.
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How To...

The information listed below is common to all Windows-based
software.  If, after following the instructions, you are still having
problems changing directories, please refer to your Windows
Manual.

Creating G codes and Saving MillCAM Designer Files:

1) Open MillCAM Designer.

2) Create a design.

3) Click "Create G code | Make File" to create a G code file, or "File |
Save As" to save the MillCAM design.

4) When creating a G code or saving the MillCAM design, the name
of your file is entered in the "Filename:" dialogue box.

The location where the file will be saved is stated opposite the
"Directory:" title.  Using default settings this should read
c:\denford\data.

5) Click the [OK] button to start creating the G code or save the
MillCAM design file.

Changing Directories:

To change the directory to read c:\denford\data, when not
displayed as listed above:

1) Using the "Directories." panel of the "File Save" window, click the
dots in the square brackets [..] until the directory is displayed as
c: drive.  The current directory is stated opposite the "Directory:"
title, directly under the filename dialogue box.  Whenever you click
on the dots in the square brackets, you will be taken back ONE
directory level.  If you do not understand directory structures,
please refer to your Windows Manual.

2) Once the Directory is displayed as the c: drive, double click
[denford] in the "Directories." panel.  The directory should now
read c:\denford

3) Double click [data] in the "Directories." panel.  The directory
should now read c:\denford\data
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Troubleshooting

Q. When trying to start the software, I receive an error stating "Dongle not present".

The software does not open.

A1. If using the keyed version, check to see that your security key (dongle) is plugged into

the parallel port and that the port is functioning correctly.

A2. If using the flash (keyless) version, contact Denford for assistance.

Q. After creating a design, I cannot create a G-code file.

A1. Check that the maximum machine time exceeds the time needed to machine the

design.

A2. If using the keyed version, check to see that your security key (dongle) is plugged into

the parallel port.

Q. When selecting a depth of cut, an error message appears stating "You cannot cut

that deep with the cutter selected".

A. Choose a different depth of cut OR increase the "Cutter Maximum Depth" for the cutter

being used.  Click "Create G code | Set G code Parameters" to access the "Set Tooling"

window.

Q. The cutter I would like to select is "unavailable".

A. The "Cutter Maximum Depth" is et to zero.  You must increase this value.  Click "Create

G code | Set G code Parameters" to access the "Set Tooling" window.  Select the cutting

tool and increase the maximum cutting depth value, then click [OK].

Q. When machining the part on my CNC machine, the tool cuts too deep into my

billet.

A. First, check that the correct depth of cut is set in the CNC program.  To do this, look at

the -Z value(s) in the CNC program.  This will tell you if the depth was set correctly in

MillCAM Designer.  If the depth appears to be correct, check the CNC machine offsets

are configured correctly.  Refer to your CNC machine manual for offset information.

Q. Why does the error message "Object Type Unknown" appear when I try to modify

the property of an element in Edit mode?

A. Dragging with the left mouse button to choose elements should only be used when

selecting multiple elements to do things like cut, copy, paste etc.  This procedure should

not be used to select individual elements for property editing - use the right mouse

button instead.

Q. The "Paste Scale" window is displaying an incorrect maximum scale.

A. Restart the MillCAM Designer software.  If the problems remains, please contact

Denford.
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Denford Limited provides unlimited Technical Support on this
software.

Technical Support is only available to registered users. If your
software was not registered with Denford Limited at the point of sale,
e-mail or fax your registration details to Denford Limited, or your
authorised Denford shipping agent as soon as possible.

When you request Technical Support, please be at your computer,
with your computer and software documentation to hand. To
minimise delay, please be prepared to provide the following
information:

• Dongle Serial Number.

• Registered user's name / company name.

• Software name and version number (found in the

"Information|About MillCAM Designer" menu).

• The wording of any error messages that appear on your computer

screen.

• A list of the steps that were taken to lead up to the problem.

Contact Details:

Denford Limited,

Birds Royd, Brighouse, West Yorkshire, HD6 1NB, UK.

Telephone: 01484 712264

Fax: 01484 722160

ISDN: 01484401157:01484401161

E-mail: service@denford.co.uk

Technical Support: Monday to Friday 8.30am - 4.30pm GMT

For USA please contact:

Denford Inc.

815 West Liberty Street, Medina, Ohio 44256, USA.

Telephone: 330 7253497

Fax: 330 7253297

E-mail: service@denford.com

Technical Support: Monday to Friday 8.30am - 4.30pm Eastern

http://www.denford.com

Technical Support
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Glossary
Access ................................. Obtain data from some storage device.

Arc ....................................... Portion of a circle.

ASCII ................................... (American Standard Code for Information) Sounds like ‘askey’.  It is a common set of

codes for letters, numbers and other characters.

Automation .......................... The automatic control of a process or system without requiring a human operator.

Baud rate ............................. The speed at which data moves from one device to another in bits per second.

Billet ..................................... The piece of material that will be machined.

CAD ..................................... (Computer Aided Design) An application program that allows a designer to draw and

edit on a computer screen, before transferring to another media.

CAM ..................................... (Computer Aided Manufacture) The use of computer driven robots and machines to

help with manufacture.

Closed-Loop System ........... A system in which the output, or some result of the output, is fed back for comparison

with the input, for the purpose of reducing the difference.

CNC ..................................... Computer Numeric Control

Command line ..................... The command line is the text entry in a dialogue box.

Computer configuration ....... The collection  of computer hardware that makes up a particular computer system.

Contouring ........................... Co-ordinated simultaneous motion of two or more axes.

Cursor .................................. The marker on the computer screen, that shows the position of the pointing device.

Dialogue box ....................... A program window that opens to allow text to be entered.

Data ..................................... The numbers, digits, characters and symbols operated on by a computer.

Directory .............................. The lettered name given to areas of your computer where files can be stored,

commonly referred to on a computer by assigned letters, e.g. c: (hard disk), a: (floppy

disk).

Disk ...................................... A magnetic storage device for external data.

DOS ..................................... Disk Operating System.  A program which controls the operation of a disk drive.

DXF File ............................... Data eXchange File. The standard file format devised for AutoCAD.

Execute ................................ Run a computer program, or carry out a single instruction.

Feedback ............................. Returning part of the output back to the input to give more accurate control.

Feedrate .............................. The rate at which the material is moved towards the cutting  tool.

File ....................................... An organised collection of related computer data and records.

Filename .............................. Filenames are titles given to your saved files.  They must not have more than eight

characters, any spaces, or punctuation e.g. millcam.

Floppy Disk .......................... A storage device for a computer.  It can be removed and used to transport data.

Folder .................................. Computer directories can contain named folders where files are stored.

Group ................................... A collection of individual elements that can be selected as if they were a single

object.

Hard copy ............................ Computer output on paper or similar media.

Hard Disk ............................. A storage device for a computer.  It cannot normally be removed from the computer,

but it is very fast and can hold a large amount of data.

Hardware ............................. Computer equipment.
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Glossary
Icon ...................................... An icon  is a small picture, displayed in Windows.  When you double click the icon,

the program associated with that icon will run.

Marquee .............................. A marquee is a box shown using dotted lines.  It is dragged completely around a set

of elements to select them.

MDI ...................................... Manual Data Input.  Information entered into a computer by manual method, e.g. a

qwerty keyboard.

Memory. ............................... The place where a computer stores data internally.

Mouse .................................. A hand-held device that moves around a flat surface and transmits details of its

position to the computer.

Network ............................... A system of connecting several microcomputers so that they can share common

facilities such as printers and hard disks.

Operating system ................ A program that controls the computer from when it is first switched on.

Parameter ............................ A value contained in a program.  Many of these parameter values can be changed by

the software user.

Post-processor .................... A program that takes a generic code and  processes it in order to produce a file

understood by a machine tool.

Program ............................... The set of instructions that makes the computer carry out the desired processes.

Program group .................... A program group, or group window is where a selection of icons can be stored

together in the Windows environment.

Simulation ............................ A computer imitation or representation of a real life situation, e.g. flight simulation.

Software .............................. The programs used in a computer.

Windows .............................. An easy to use environment that uses icons, a mouse and windowed user areas as

the computer operating system.

WYSIWYG ........................... (What You See Is What You Get) A phrase used to describe a program that shows on

the screen  what you will get on paper.
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Index
Index

A
Advanced

Program Setup Example ........................ 50
Advanced Menu

Attach ..................................................... 39
Group ..................................................... 38
Lock Axes .............................................. 39
Settings .................................................. 39
Show / Hide ............................................ 37
UnDelete ................................................ 38
UnGroup ................................................ 38
View Group IDs ...................................... 38

Alter Material Size ........................................ 32
Attach Tolerance (Setting) ............................ 47
Attaching to End Points ................................ 39

B
Billet ............................................................. 17

C
CAD/CAM .................................................... 5
Change Step Size ........................................ 26
CNC ............................................................. 5
Copy ............................................................. 33
Create G-code menu

Make file... .............................................. 40
Set G-code parameters... ....................... 42

Custom G-code Set-up ................................. 46
Cut ............................................................... 33
Cutter Diameter ............................................ 27

D
Data Panel ................................................... 18
Depth of Cut ................................................. 28
Design Window

Data Panel ............................................. 18
Layout .................................................... 18
Titlebar ................................................... 18
Work Area .............................................. 18

Direct Data Entry .......................................... 48
Dongle

Fitting ..................................................... 8
Serial Number ........................................ 44

DXF File ....................................................... 31, 32

E
Edit

Button .................................................... 25
Edit Menu

Copy to... ................................................ 35
Cut ......................................................... 33
Mirror... ................................................... 34
Paste ...................................................... 33
Paste from... ........................................... 35
Paste Special... ...................................... 34
Refresh Screen ...................................... 35
Rotate... ................................................. 35
Select All ................................................ 35

Element Buttons
Arc ......................................................... 20
Box ........................................................ 21
Circle ..................................................... 22
Cutter ..................................................... 27
Depth ..................................................... 28
Edit ........................................................ 25
Frame .................................................... 21
Line ........................................................ 19
Ring ....................................................... 22
Step ....................................................... 26
Text ........................................................ 23

Exit ............................................................... 32
Export DXF File ............................................ 32

F
File Menu

Alter Material Size .................................. 32
Change Font .......................................... 32
Copy ...................................................... 33
Exit ......................................................... 32
Export DXF File ...................................... 32
Import DXF File ...................................... 31
New ........................................................ 29
Open... ................................................... 29
Print ....................................................... 32
Printer setup ........................................... 32
Save ....................................................... 30
Save As... .............................................. 30
Save Project... ........................................ 30

Flash ............................................................ 8
Fonts

Change Font Menu ................................. 32
List of Available ...................................... 24
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Index
G
G-code

Custom Set-up ....................................... 46
Parameters Layout ................................. 42
Parameters Text ..................................... 43
Save File ................................................ 40

Grid Lock ...................................................... 26
Grid Menu

Custom... ............................................... 36
Grid Colour ............................................. 36
Grid OFF ................................................ 36
Grid to (number) mm .............................. 36

Grouping Elements ....................................... 38

H
Help Menu

About MillCAM Designer ........................ 44
Help Screens ......................................... 45

I
Import DXF File ............................................ 31
Installation

Network .................................................. 54
Windows 3.xx ......................................... 9
Windows 95/98/NT ................................. 10

Introduction ................................................... 5

L
Lock MCD2.ini File ....................................... 52
Locking the Axes .......................................... 39

M
Machining Order

See Note/Tip .......................................... 12, 15, 19
Machining Time (Setting) .............................. 46
Manual Data Input ........................................ 48
Marquee Box ................................................ 24
Material Window

Layout .................................................... 16
Options .................................................. 17

MCD2.ini File ................................................ 50
Mirror ............................................................ 34

N
Network ........................................................ 54
New File ....................................................... 29

O
Open File ...................................................... 29

P
Paste ............................................................ 33
Print .............................................................. 32
Program Structure ........................................ 49

Q
Quickstart ..................................................... 12

R
Refresh Screen ............................................ 35
Rotate ........................................................... 35

S
Save

G-code File ............................................ 40
MillCAM File .......................................... 30

Select All ...................................................... 35
Set Arc Angle ............................................... 20
Set Cutter Depth ........................................... 28
Setup System File ........................................ 46
Start-up Defaults .......................................... 47
Step .............................................................. 26
System Requirements .................................. 7

T
Technical Specification ................................. 53
Technical Support ......................................... 60
Text Input ...................................................... 23
Titlebar ......................................................... 18

U
UnDelete ...................................................... 38
Uninstall (see note) ...................................... 11

W
Windows 3.xx ............................................... 9
Windows 95/98/NT ....................................... 10
Work Area .................................................... 18
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Supplement to MillCAM Designer 2

User Manual -

Version 2.21 New Features.

Total Commitment to Education and Training WorldWide.

Disclaimer We take great pride in the accuracy of information given in this

supplement, but due to nature of software developments, be aware

that software specifications and features of this product can change

without notice.  No liability can be accepted by Denford Limited for

loss, damage or injury caused by any errors in, or omissions from,

the information supplied in this supplement.

Screenshots Please note that any screenshots are used for explanation purposes

only.

Language This supplement is written using European English.

Contact Any comments regarding this supplement should be referred to the

following e-mail address:  customer_services@denford.co.uk

Updates Any updates to this supplement will be posted in the "Downloads"

section of the Denford website:  http://www.denford.co.uk

Supplement Content This supplement outlines the new features added to MillCAM

Designer, versions 2.21 and above:

About this Supplement.

• The ability to group a number of individual elements into single

objects (via the new "Advanced" menu).

• The ability to snap to the end point of the last drawn line (via the

new "Advanced" menu).

• The ability to lock the axes in the working area (via the new

"Advanced" menu).

• The ability to export DXF files (via the "File" menu).

• New installation program.
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Installing MillCAM Designer
Follow these instructions to install the Denford MillCAM Designer

software onto a computer running Windows 95/98/NT.  Whilst

running Windows on your computer:

1) Insert the MillCAM Designer CD-ROM into your CD-ROM drive.

If the autorun feature is enabled on your computer, the "MillCAM

Designer Installation" start-up window will automatically appear -

move to section 4).  Otherwise continue as outlined below.

2) Double-click the left mouse button on the "My Computer" icon. In

the "My Computer" window find your floppy disk drive icon

(usually labelled "d:" or "e:" and double-click the left mouse

button on this icon.

3) The contents of the CD-ROM will be displayed in a new window.

Double-click the left mouse button on the file named "Start.exe"

to display the "MillCAM Designer Installation" start-up window.

4) If you have been supplied with a flash screen version of MillCAM

Designer, insert your "Registration" floppy disk when prompted.



MillCAM Designer 2 User Manual - Version 2.21 New Features 3

Installing MillCAM Designer

It is recommended that

you allow the Denford

installation program to

create its own

directories and set up its

default values.  If you

find these inconvenient,

then feel free to alter

them.

  Note - x

5) Select the correct type of installation from the two choices;

"Standard", for stand-alone computers, or "Network", for multiple

computers linked together by a network.

Select the area of your hard-disk where the program files can be

installed, together with any program and folder names.  Network

users can find additional installation instructions on pages 50-51

of your main "MillCAM Designer 2 User Manual".

6) Your computer must be restarted before using MillCAM Designer

for the first time.

Ensure that keyed versions of the software have the dongle fitted

to the parallel port of your computer.  Your parallel port may be

labelled as the "printer" port and is usually positioned on the back

panel of your computer.

If you did not receive a dongle, you will be using a flash version

of the software (in which case your details would have been

registered via floppy disk in section 4).

To uninstall MillCAM

Designer, click "Windows

Startbar | Settings |

Control Panel | Add/

Remove Programs",

then highlight "Mill Cam

Designer" and click [OK].

  Note - x
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Changes to the File menu.

The "File" menu now contains the

following additional option:

"Export DXF File"

Click this option to save the contents of

the working area, using the DXF (Data

eXchange Format) standard.

The "Advanced" menu can be displayed or

hidden from the menubar, according to the

requirements of the user.  The default

setting is hidden.

The new Advanced menu.

If the "Advanced" menu is hidden, press your keyboard [Alt + S]
buttons to display the "Setup System File" window (shown on the
next page).  Click inside the "Show Advanced Menu" checkbox, so a
tickmark is displayed (shown below).  Save any work, then restart
the MillCAM Designer program.  The "Advanced" menu will now be
displayed.
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The new Advanced menu.

Options available:

"UnDelete"
Click this option to place the last deleted element back into its
original position in the working area.  If a number of elements have
been deleted, each one can be recovered in sequence, using this
option.
Keyboard shortcut: [Alt + BkSp].

"Group"
Highlight a number of individual elements, then click this option to
group them together as one large object.  When a marquee box is
drawn around any element belonging to a group, all the associated
elements in that particular group are automatically selected.
Note: When text characters are drawn, the elements used to
compose each character are automatically grouped upon creation of
the text character.

"UnGroup"

Click this option to separate a selected group into its individual

elements.
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"View Group IDs"

Click this option to view the current groups present in the working

area.  Each group is defined by a number.  This group number is

displayed on each element that belongs to the group.

Click the "View Group IDs" menu text to switch the option on (a

tickmark is displayed) or off (a tickmark is not displayed).

The new Advanced menu.

"Attach"

When this option is switched on, the start point of any new element

you draw is automatically snapped to the end point of the element

nearest to your cursor.

Click the "Attach" menu text to switch the option on (a tickmark is

displayed) or off (a tickmark is not displayed).

Above: Two groups are shown in this screenshot:

group 1 (on the right) and group 2 (on the left).

The sensitivity of the "Attach" command can be adjusted using the

"Attach Tolerance" option, in the "Setup System File" window (menu:

"Advanced|Settings").  This defines the size of the snap-to line

boundary in pixels.
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The new Advanced menu.
"Lock Axes"

When this option is switched on, the start and end points of any new

elements can only be positioned horizontally or vertically within the

working area.

In other words, once you place the start of an element, you can only

draw along the directions of the X and Y axes.

Click the "Lock Axes" menu text to switch the option on (a tickmark

is displayed) or off (a tickmark is not displayed).

Above: "Lock Axes" switched off. Above: "Lock Axes" switched on.

"Settings"

Click this option to display the "Setup System File" window (shown

at the bottom of page 5).

Changes to the Help menu.

The "Information" menu is no longer

used in MillCAM Designer versions 2.21

and above.

Any options originally found in the

"Information" menu are now accessed

using the "Help" menu.
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Changes to the Create G-code menu.
The "Create G-code" menu now contains the following additional

option:

"Export to VR Milling"

Click this option to create a G-code file, then automatically load the

file into the Denford VR CNC Milling software package.  This feature

is only enabled when VR CNC Milling is running.

 Denford Limited reserves the right to alter any specifications and documentation

without prior notice.  No part of this supplement or its accompanying documents may

be reproduced or transmitted in any form or by any means, electronic or mechanical,

for any purpose, without the express written permission of Denford Limited.

All brands and products are trademarks or registered trademarks of their respective

companies.

Copyright Denford Limited.

Version update-2.08.01 - 2001.

All rights reserved.

Document: a5 millcam v2_2 update.p65

Changes to Arc Drawing.

Changes to Edit Mode.

This option is only

available in MillCAM

version 2.22+ and

requires VR CNC Milling

version 2.90+.

  Note - x

When drawing an arc, the angle of the arc can be changed using the

[up and down arrow] keys.  To change the angle of the arc in

smaller increments, hold down the [SHIFT] key whilst pressing the

[up and down arrow] keys.

When editing a drawing, multiple elements can be selected by

clicking on each element in turn, whilst holding down the [CTRL]

key.

For example, select element 1.  Hold down [CTRL], then select

element 2.  Continuing to hold down [CTRL], select elemant 3.  All

three elements are now selected.

Don't forget your selection can now be grouped together, using the

menu command "Advanced | Group".


